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Disclaimer
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Antivirus Considerations
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For technical support and the latest news of upgrades, documentation, and related products,
visit the Vizrt web site at www.vizrt.com.
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1 VizEngine5.4.1

Release Date: 2025-11-19

These are the release notes for Viz Engine version 5.4.1. This document describes the user-visible changes that have
been made to the software since release 5.4.0

Note: Viz Artist maintains its release notes in a separate document starting from version 3.12.0.

1.1 Installer Notes

1.1.1 General

The Software ships with a bundle installer containing all necessary components. It is recommended to use the
bundle installer when setup needs to be done manually.

¢ The Setup application (both MSI and Bundle installer) must be run in Administrator mode.
¢ Visual C++ Redistributable files are no longer part of the .msi setup file. These files are now installed with the
bundle setup application (VIZENG-13210, VIZENG-12629, VIZENG-12701).
The bundle setup application installs or upgrades Viz Artist together with its required Visual C++
Redistributable files (VIZENG-12936, VIZENG-13804).
All files contained in the bundle setup application can be extracted using the /dump command line option.
This creates a sub-folder where the files are extracted (VIZENG-13020).
Multiple installations of Viz Engine are not supported.
The installer automatically upgrades (replaces) any existing Viz Artist/Viz Engine 3.x installation. However,
downgrading is currently not supported (VIZENG-7098).
If Adobe After Effects is installed after Viz Engine, the Viz installer needs to be executed again to install the AE
plug-in (VIZENG-7876).
The user account must have SeCreateGlobalPrivilege (SE_CREATE_GLOBAL_NAME) enabled.
The configuration profiles shipped with Viz Engine guarantee a correct Audio/Video delay, to have a proper
lip-sync setup or a correct video wall installation. A manual configuration (for example, number of inputs,
clips, etc.) is still required, after applying these profiles (VIZENG-18861).
To use Global Illumination in Viz Artist/Viz Engine, at least Direct X version 9 is required. (VIZENG-19983).
¢ Download the DirectX End-User Runtimes (June 2010):
® Microsoft Download Link: Download DirectX End-User Runtimes (June 2010) from Official
Microsoft Download Center
e Extract the files:
® Run the downloaded .exe and select a folder for extraction.
* After extraction, navigate to that folder and run DXSETUP.exe.
e Complete the installation:
¢ Thisinstalls all missing legacy DLLs, including d3dx9_43.dll.
* The Basic, Viz DataPool, Viz PixelFX, Viz Maps, Viz Extension and Viz Socialize plug-ins are released together
with Viz Engine, starting with version 4.0.0, and are included in the bundle installer. The basic plug-ins are
installed by default.

Copyright © 2025 Vizrt Page 9
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Note: In case of installing Viz Engine with the individual MSl installer and not the Viz Artist Bundle installer,
ensure all runtime dependencies are up-to-date (for example, Viz Engine does not start with an outdated
Microsoft Visual C++2015-2022 Redistributable (x64) version). The minimum required version is
14.40.33810 (https://aka.ms/vs/17/release/vc_redist.x64.exe).

If Microsoft Visual C++2015-2022 Redistributable (x64) - 14.40.33810 is already installed and Viz Engine is
not starting, the runtime installation could be damaged. Reinstall the runtime redistributable in this case.
The related installer is part of the Bundle installer.

© Information: In case of upgrading from previously installed versions, and the upgraded version comes
with a new CodeMeter version, make sure that all the applications installed using CodeMeter on the same
host, are still running.

1.2 Fixed Issues

1.2.1 Fixed Issues: General
Key Summary

VIZENG-34211 DataManipulate in Viz Engine Renderer causes Viz Engine issues

VIZENG-34088 Viz doesn't start when AudioOn =1 on certain hardware

VIZENG-34075  Viz Engine 5.4.0 crashes with TL and SUBSCENE workflow (Classic)

VIZENG-34048  Issue retrieving Scene Tree statistics

VIZENG-34025 | Audio distorted when playing back multiple audio files

VIZENG-34024 | License error messages are only shown once when local Wibu dongle isn't available anymore

VIZENG-33998 | Crash in RenderToDiskManager database notification code

7 issues

1.2.2 Fixed Issues: Renderer
Key Summary
VIZENG-34229 High GPU utilization after initializing scenes

VIZENG-34092 Crash when using TFx plugins with text underline

VIZENG-34080 Text issues with specific Hindi Font

Copyright © 2025 Vizrt Page 10


https://aka.ms/vs/17/release/vc_redist.x64.exe
https://vizrt.atlassian.net/browse/VIZENG-34211
https://vizrt.atlassian.net/browse/VIZENG-34211
https://vizrt.atlassian.net/browse/VIZENG-34088
https://vizrt.atlassian.net/browse/VIZENG-34088
https://vizrt.atlassian.net/browse/VIZENG-34075
https://vizrt.atlassian.net/browse/VIZENG-34075
https://vizrt.atlassian.net/browse/VIZENG-34048
https://vizrt.atlassian.net/browse/VIZENG-34048
https://vizrt.atlassian.net/browse/VIZENG-34025
https://vizrt.atlassian.net/browse/VIZENG-34025
https://vizrt.atlassian.net/browse/VIZENG-34024
https://vizrt.atlassian.net/browse/VIZENG-34024
https://vizrt.atlassian.net/browse/VIZENG-33998
https://vizrt.atlassian.net/browse/VIZENG-33998
https://vizrt.atlassian.net/issues/?jql=project+%3D+VIZENG+AND+issuetype+%3D+Bug+AND+status+%3D+Closed+AND+%28fixVersion+in+%28VizEngine-5.4.1%29%29+AND+%22Release+Notes+Status%22+in+%28Done%2C+Needed%29++and+resolution+in+%28Fixed%2C+Done%2C%22Test+passed%22%29++++AND+component+in+%28Core%2C+Animation%2C+CommandInterface%2C+PluginAPI%2C+Scripting%2C+Security%2C+Stage%2C+Superchannel%2C+VS%29+and+%21%28Summary+%7E+%22Black+Duck*%22%29+AND+%28labels+NOT+IN+%28Security%29+OR+labels+IS+EMPTY%29++&src=confmacro
https://vizrt.atlassian.net/browse/VIZENG-34229
https://vizrt.atlassian.net/browse/VIZENG-34229
https://vizrt.atlassian.net/browse/VIZENG-34092
https://vizrt.atlassian.net/browse/VIZENG-34092
https://vizrt.atlassian.net/browse/VIZENG-34080
https://vizrt.atlassian.net/browse/VIZENG-34080

Key

VIZENG-34075
VIZENG-34048
VIZENG-34036
VIZENG-34017
VIZENG-33803

VIZENG-33770

9 issues
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Summary

Viz Engine 5.4.0 crashes with TL and SUBSCENE workflow (Classic)

Issue retrieving Scene Tree statistics

Scene Editor View does not match the scene aspect ratio in VER Scene
Heavy GPU usage when starting Trio and renderengine_version_default =V3
Live input freezes inside the Superchannel A to B switch happens

Garbage mask flickering on the camera switch with delay bigger than 2

1.2.3 Fixed Issues: Video 10

Key

VIZENG-34253
VIZENG-34213
VIZENG-34095
VIZENG-34079
VIZENG-34058
VIZENG-34055
VIZENG-34044
VIZENG-34030
VIZENG-33991

VIZENG-33803

10 issues

Summary

Clip jitters on play

Script command script Clip.Play(fromframe) stops audio if clip is already playing

Audio: OGG and WAV issues with container copy

Texture Renderer clips set to live play are using resources, even they aren't used inside the scene.
Matrox Clip Player skips audio for 10 frames

Engine freezes when receiving a specific character in Closed Caption while CC Extraction is used
HVEC clip doesn't play inside the stage

When using IGMPv3 audio and ancillary data flows don't store the source IP address

Uneven Height Content used in Interlaced Super Channel or Clip Channel cause a crash

Live input freezes inside the Superchannel A to B switch happens

Copyright © 2025 Vizrt Page 11
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https://vizrt.atlassian.net/browse/VIZENG-34017
https://vizrt.atlassian.net/browse/VIZENG-34017
https://vizrt.atlassian.net/browse/VIZENG-33803
https://vizrt.atlassian.net/browse/VIZENG-33803
https://vizrt.atlassian.net/browse/VIZENG-33770
https://vizrt.atlassian.net/browse/VIZENG-33770
https://vizrt.atlassian.net/issues/?jql=project+%3D+VIZENG+AND+issuetype+%3D+Bug+AND+status+%3D+Closed+AND+%28fixVersion+in+%28VizEngine-5.4.1%29%29+AND+%22Release+Notes+Status%22+in+%28Done%2C+Needed%29++and+resolution+in+%28Fixed%2C+Done%2C%22Test+passed%22%29+AND+component+in+%28Classic%2C+Renderer%2C+PostProcessing%2C+Text%2C+UnrealIntegration%29+and+%21%28Summary+%7E+%22Black+Duck*%22%29+and+labels+not+in+%28Security%29++&src=confmacro
https://vizrt.atlassian.net/browse/VIZENG-34253
https://vizrt.atlassian.net/browse/VIZENG-34253
https://vizrt.atlassian.net/browse/VIZENG-34213
https://vizrt.atlassian.net/browse/VIZENG-34213
https://vizrt.atlassian.net/browse/VIZENG-34095
https://vizrt.atlassian.net/browse/VIZENG-34095
https://vizrt.atlassian.net/browse/VIZENG-34079
https://vizrt.atlassian.net/browse/VIZENG-34079
https://vizrt.atlassian.net/browse/VIZENG-34058
https://vizrt.atlassian.net/browse/VIZENG-34058
https://vizrt.atlassian.net/browse/VIZENG-34055
https://vizrt.atlassian.net/browse/VIZENG-34055
https://vizrt.atlassian.net/browse/VIZENG-34044
https://vizrt.atlassian.net/browse/VIZENG-34044
https://vizrt.atlassian.net/browse/VIZENG-34030
https://vizrt.atlassian.net/browse/VIZENG-34030
https://vizrt.atlassian.net/browse/VIZENG-33991
https://vizrt.atlassian.net/browse/VIZENG-33991
https://vizrt.atlassian.net/browse/VIZENG-33803
https://vizrt.atlassian.net/browse/VIZENG-33803
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1.3 Security Updates

Key Summary
VIZENG-34214 = CVE-2025-23345, CVE-2025-23309, CVE-2025-23352: Update Nvidia driver to 573.76 / vGPU 18.5

VIZENG-34152 CVE-2025-10585: Update Chromium Embedded Framework

2 issues

1.4 Changes

1.4.1 Upcoming Changes

¢ In the next version of Viz Engine, support for SNMP will be completely removed.

1.4.2 Changes: Renderer

e Viz Engine 5.4.1 added support for custom aspect ratios inside the Scene Editor. Therefore, adaptive scenes
might look wrong if the scene is not set to Format in Camera Aspect Scene Settings.

* NVIDIA Kepler GPUs were set as deprecated (NVIDIA isn't supporting Kepler boards in newer driver versions
anymore).

¢ The final position and size of scaled image channels in DVE mode might change by 1 pixel after fixing
rounding issues.

1.5 Known Issues

1.5.1 General

* Saving a new scene with references that do not exist anymore fails. Those references need to be removed
manually to save the scene.

* Importing HDR images with special characters in its file name from a drive with 8dot3 disabled fails.

* Transition Logic scenes require to have GeomAutoFree = 1 set in the Viz Config file. With inactive
GeomAutoFree, system stability is not guaranteed.

* Interactive Applications within a GFX channel only work in DVE mode in Fullscreen or if the GFX channel has
an offset in Fullscreen. Scaled GFX channels or plug-ins that rely on screen coordinates (Graffiti) are not
supported.

* Bones and Skin live motion data tracking requires Tracking Hub 1.1.2 (released together with Viz Engine
3.11).
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Viz Engine REST interface does not start if a user is Non-Admin (VIZENG-23386).

e On Air output shows wrong field-of-view if AuxRenderer is enabled, PP in scene editor is disabled and Viz
Engine is not in On Air mode.

® The Toggle plug-in can not handle the background loading of objects or scenes.

e Oversized snapshot requests (bigger than the configured output resolution) in the Classic Render Pipeline
aren't supported. Use the Viz Engine Render Pipeline instead.

® The clog command now includes all child processes. Upon abnormal end, all child processes are
terminated before a restart is attempted (VIZENG-11361).

* SNMP is deprecated by Microsoft. To use SNMP with Viz Engine 5.4.0, SNMP and VBScript must be manually
installed as Windows Components before installing the Viz Engine. See also Upcoming Changes.

e Scaling directors down can cause keyframes to be scaled down to 0.0. These values do not recover when

scaling directors up again afterwards (VIZENG-31610).

Key Summary

VIZENG-34277  [MIGRATION] Text fgColor keyframes not preserved when 3.14.5 scene is opened in 5.4
VIZENG-27515  AJA10: Embedded Audio only available if SDI Input enabled
VIZENG-33562  Allow round-trip conversion between dynamic and static geometries
VIZENG-34094  animation for Sub Scene jumps from one director to another
VIZENG-32623  Assets flicker on video wall system

VIZENG-29680  Change Audio Backend on EAS

VIZENG-32400  Changing Spline types is not considered in Undo/Redo
VIZENG-31745  Consider Gamma Correction in Material Definition Icon Generation
VIZENG-28452  Consolidation of logging settings and configuration

VIZENG-27866  Enable individual volume control for tracks

VIZENG-31127  Experimental: Reduce overall in-to-out delay in Fast Texture Mode
VIZENG-28344  GH Sync: support main/replication setup

VIZENG-33515  Importing multiple AE scenes at the same time fails

VIZENG-30569  Improve Undo/Redo performance on larger Gl scenes

VIZENG-24017  Improve VizEngine startup time

VIZENG-29589  Maya 2024 doesn't support Viz Maya plugin
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Key Summary

VIZENG-31624  Optimize transform update

VIZENG-33414  Renderer: DVE placeholder not visible in Front or Back layer

VIZENG-31946  Renderer: opaque materials affects key in overlay sequence

VIZENG-34209  Scene with ezJavascript plugin crashes when used inside a GFX channel
VIZENG-32399  Stop/Pause/Tags are not considered in Undo/Redo

VIZENG-29623  Text: global config for default font style

VIZENG-34267  TNT Project crash in Editor mode after 20-24h

VIZENG-26964  Used lens distortion parameters not in sync with main scene

VIZENG-33601  VizEngine does not always switch back to GH main after main shutdown and startup

VIZENG-34221  Wall engine running with FULLSCREEN 59.94Hz runs at 50Hz in Software 1/0 mode

26 issues

1.5.2 Installation

* Do not use the C4D Version 15R2 patch file(s) unless you are using this version. Otherwise, it prevents
Cinema 4D R16 from starting up.

* When uninstalling Viz Engine, the installer might report that links could not be removed. Please check that
none of the desktop.ini files of Windows have write protection. For example, Skype seems to change the
permissions of some desktop.ini files with every update.

1.5.3 Windows 10

* Right-clicking on the Taskbar icon of Viz Engine starts a new instance. Starting an additional VizGui process
is prevented on Windows 10.

* Error message "Windows Media Player Rich Preview Handler has stopped working while opening specific
clips with Softclip x64". To fix, open Windows Explorer > Tools > Folder options > View tab, and
deselect Show preview handlers in the preview pane.

1.5.4 Videowall

¢ |t might happen that Viz Engine is running at half speed on videowall, but goes back to full speed if another

window comes into focus. If so, start viz.exe -y -w,instead of the regular videowall mode viz.exe

-n —-w.
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¢ GFX channels with Alpha != 100% decrease render performance. On video wall setup,
gfx_channels_antialiased = 0 should be turned off in the Viz Configuration
section RENDER_OPTIONS.

¢ Windows scaling can lead to unwanted side effects.

® The maximum resolution on videowall setups is limited to 16392px by 16392px.

* Enabling video output for Video Wall setups is not recommended for performance reasons. It is
recommended to grab the audio from one of the HDMI/DP outputs of the NVIDIA GPU and use an Audio
embedder instead.

1.5.5 Configuration

¢ Specifying a path in the configuration file including the # character is not supported. Such paths are cut
before the # character.

1.5.6 Viz Engine Render Pipeline

* Existing Scenes using Global lllumination might need a precompute again to enable debug views.

¢ Background loading of external images (filesystem, network locations, etc.) is not supported. Images from
Graphic Hub should be used.

¢ Flexbox labels in Scene Editor do not support Unicode characters.

1.5.7 Classic Render Pipeline

¢ Scene Transitions within GFX channels or Superchannels are not supported.

¢ Soft Shadow intensity is currently not working together with Global Illumination.

* We recommend using a warmup scene showing all needed assets once. Under certain circumstances, video
and clip surfaces can show up red the first time being used.

® Playing Audio clips on systems with no physical audio hardware available stops the renderer. You need to
turn off audio in the configuration file.

* On some systems with hybrid graphics, like laptops, the dynamic swapping must be disabled in the BIOS
and the stronger GPU must be assigned as default.

¢ Stencil-based shadows (Caster/Receiver) do not work on rotated geometry.

® When changing CurlAuthUnsafe = 1,VizOne Browser does not work anymore.

¢ VGA Fullscreen Output is only active if offscreen rendering is turned off. Setting offscreen=0 in
section RENDER_OPTIONS enables fullscreen output.

* Blending cubemapped images are not supported.

® Cubemapping with Browser plug-in is not supported.

* Fonts need to be re-imported to use new Pathrendering or Razor fonts technology.

* Masks are not supported on Path rendered Fonts (VIZENG-13737).

® Do not send other commands than IS_RENDERER_READY and database connection commands before
this command returns 1 , otherwise the renderer and video output might not be initialized.

e |f you encounter stability issues with an NVIDIA driver or issues during driver installation, uninstall the old
NVIDIA driver completely, delete the folder C:\Program Files\NVIDIA Corporation\installer2, install the new
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driver and select Custom installation, then check-mark the perform clean installation option and finish the
installation.
Enabling background loading might decrease the render performance by up to 15 frames per second. This is
due to OpenGL requirements.
M-Zone keyer only works with HD when rendering with full frames.
Decreased render performance in HD since Viz Engine 3.5.0 when the ringing filter is activated. Before Viz
Engine version 3.5.1 there was no ringing filter for HD. Turn off the ringing filter via configuration or scene-
setting to get the same performance.
Sporadic NVIDIA driver error The NVIDIA OpenGL driver lost connection with the display driver and is unable
to continue. which in turn causes Viz Engine to freeze. Make sure that the driver profile Workstation App >
Dynamic Streaming is selected. Always use the recommended NVIDIA driver for your GPU.
Possible performance problems with scenes imported from Viz Engine 2.x. Check the following settings
(applies to old 2.x scenes only):
¢ Image Combining should be set to Multi Texturing in the Render options in the configuration (or
flag combine_with_multitex = 1 inthe configuration file)to avoid inefficient image
combining.
® Set Key Render Mode to Single Pass in the rendering options in the configuration. The Key Render
Mode can also be set on scene level. Available options are:
¢ Config (inherit the setting from the configuration).
¢ Single Pass (fill and key are rendered in a single pass).
® Double Pass (fill and key are rendered in separate rendering passes).
Key rendering results differ between these options for compatibility reasons.
Use Single Pass scenes imported from Viz Engine 2.x and Double Pass for Viz Engine 3.x scenes.
The configuration flag exec_all_animations inthe section RENDER_OPTIONS should be setto 0 ifit
is not necessary to execute hidden animations.
Turn off the VGA preview in On Air mode to avoid performance drops due to multiple rendering of the scene
(applies only to video version of Viz Engine).
Hide containers that are not required for the current animation.
Re-import fonts directly with the Viz Engine.
Grid picking currently only works for Cube and Cylinder geometry.
The behavior of scripts with cyclic dependencies to other scripts is undefined. Avoid cyclic dependencies.
Bad performance when using multiple dynamic scenes, even if they are set inactive. To avoid unnecessary
updates, change the Update mode in Dynamic Scenes to Auto instead of Always.
CLR LOAD command can crash Viz if not used correctly. Required function signature: static int
pwzMethodName(String pwzArgument).
Alpha setting for DVEs is not correctly supported when a scene is used nested using a GFX channel
(VIZENG-10212).
Glow plug-in drops performance when used on multiple containers and rendered within a GFX channel or
viewport tile (Classic pipeline) (VIZENG-11342).
Scene transitions do not work when dynamic images from different folders are involved. Dynamic images
always need to be stored directly in the root folder dynamic and references must point there. Dynamic
images in a subfolder of the dynamic folder or any other folder are not found.
Font option "lighted" has no effect on fonts rendered with type "vector" (VIZENG-18941)
16-bit PNG images are not rendered properly when imported with compression.

Copyright © 2025 Vizrt Page 16



Viz Engine Release Notes - 5.4

1.5.8 Unreal Integration

Note: It is not advisable to utilize the Unreal integration in production environments outside of Game
Mode. For instructions on how to initiate Unreal in Game Mode, please consult the Viz Artist User Guide
Chapter Third Party Integrations.

Unreal Engine 5.x with Temporal Super Resolution (TSR) enabled can lead to flicker issues when used in
combination with NVIDIA Driver 528.89. Changing to FXAA solves the issue.

Unreal Engine 5.5 with DLSS enabled can lead to memory issues.

* Due to a technical limitation in Unreal Engine 5.6, this version is not yet supported by Vizrt Media Plugin.

1.5.9 Post Renderer

¢ Because of performance issues rendering fullscreen sequences in UHD is not supported.

® Ghosting effect in post-rendered interlaced video: Make sure that the Flicker Filteris setto @ in the post-
rendering options of the Video Render plug-in.

¢ Post-rendering does not work properly if onair_no_videoout flag = 1 (Videowall mode).

¢ Post-rendering does not work properly if TriCaster integration is active and the output format is set to User
Defined or Fullscreen.

* DVCPRO expects 720x480 in NTSC resolution. Please set the correct output width in AVIRenderer.

® The alpha channel cannot be rendered with Intel Indeo 5.10 codec. This codec is not supported.

¢ iz Engine might crash if certain VfW codecs are used on non-Matrox installations in Post Render Mode.

1.5.10 Matrox

® Enable Hardware DVE/(Fast Texture Mode) is only available for two instances.

® The configuration ClipIn[n].UseV210 and ClipInl. ContainsAlpha are mutually exclusive and should not be
enabled at the same time.

* The overall delay is one field higher than in previous versions using 103 This is caused by the required A/B
buffer of 10 4.

e A program output channel needs to be defined. Pure preview or Cleanfeed is not supported.

* HDR output on UHD 2SI requires at least a Quadro P6000 GPU.

® Large Canvas setups require a RTX5000 Ada or higher.

e Mixing different frame rates with clips processed by a M.264 board is not supported and causes jittering.

¢ Upgrading the FPGA can cause a PCl error during the boot process on certain systems. Unattended
upgrading of the FPGA is not recommended.

¢ Watchdog is only supported in 50/60M and 60Hz frequencies.

* When using 3G formats (1080p/UHD) or the Zero-Frame-Delay Mixer, auto-sensing of the sync signal is not
supported due to incompatible H-/V-phases, that are set in the process.

* Instead, either Tri-Level or Blackburst must be used together with correct H-/V-Phase. This might resultin a
missing key signal (VIZENG-11708).

* For dual channel systems, please perform the following steps after enabling the watchdog to ensure the
correct state is written to the Matrox Board:

a. Start Channel 1.
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b. Wait until channel has started up and topology has been written.
c. Start Channel 2.

d. Wait until channel has started up and topology has been written.
e. Exit channel 2.

f. Exit channel 1.

g. Start channel 1.

h. Wait until channel has started up and topology has been written.
i. Start channel 2.

ClipOut channel does not work when Matrox0.VideoOutl.FrameBufferDelay is set to zero (VIZENG-16373).
UHD Clip Playback with M264 S1/S2/S3 alone requires color conversion on the shader level. (VIZENG-20700).
Two Sample Interleave (2SI) clips played as DVE are not supported.

Cutting of Audio tracks should not be done at all, as this results in a crackling noise. Always use a cross-fade
to change audio sources.

Monitoring live, clip and genlock status via SNMP is not supported (SNMP was deprecated and is no longer
supported by Microsoft).

Certain M4V clips may cause Viz Engine to lock and flood the console with errors when being played in a
loop.

Running interlaced AVC-Intra 100 clips on M.264 boards may lead to instabilities when played non-stop over
several hours.

Always verify the Destination Connector when changing/adding configurations of output channels.

1.5.11 X.mio3 Boards

If the Viz instance is closed unexpectedly, the X.mio3 topology might become unusable. To reset the
topology, enable ResetTopology in the config file, restart Viz, close it and start Viz again.

Turning on the Cleanfeed Feature increases the delay by one frame.

It is not recommended to change the frame group of any input signal while Viz Engine is running.

Only two DVE UHD inputs are supported at 50Hz. For 60M formats, only two texture inputs are supported.
Animating UHD DVE scaling might result in jittering. You need to increase the VideoDelayDVE settingto 2 .
Texture delay with PAL/NTSC, and Enable Hardware DVE is five fields instead of four fields. (VIZENG-16955).
When using watchdog together with a clean feed, the watchdog triggers on the clean feed connector rather
than the program output (VIZENG-16589).

1.5.12 X.mio5 Boards

Standard Definition (PAL and NTSC) resolutions are not supported by X.mio5 IP boards according to the
SMPTE ST 2110 standard.

Streampunk ledger RDS does not list the Matrox X.mio5 nodes. This is due to some old NMOS APIs that are
partially deprecated.

Riedel Explorer fails listing the X.mio5 nodes. Riedel Explorer automatically selects NMOS API Version 1.3
instead of 1.2. Itis possible to select the used API version manually if you switch to static mode and/or
enable version downgrade in the Riedel Explorer.

The X.mio5 board has been tested to support up to 12 Inputs (1080i 50 and 60M) on a 10GbE network.
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1.5.13 DSX.core

After the installation of the DSX-core client version of the driver perform the following steps:

1. Unregister mvfDsxCore.dll.
a. Click Start > Run (or use the Windows command line: Search > CMD > (Right click) Run as
Administrator)

b. Type REGSVR32 /U "C:\Program Files\Matrox DSX-

TopologyUtils\System64\mvfDsxCore.dll" and press ENTER.

2. Shut down http://X.info in the task manager (mveXinfo.exe).
3. Delete mvfDsxCore.dll from the folder C:\Program Files\Matrox DSX-TopologyUtils\System64\.
4, Start http://X.info (mveXinfo.exe).

1.5.14 Other Video Boards

* When Viz Engine is in On Air mode, there might be audio distortions using Bluefish cards (VIZENG-8853).
¢ Bluefish Supernova S+ cards can only be used in a Virtual Set Environment if the board is synced to
Blackburst/Trilevel.

1.5.15 NDI

Security Updates Windows 11 - KB5063878 and Windows 10 - KB5063709 can lead to traffic drops in NDI output.

1.5.16 NVIDIA

* When the computer is running out of virtual page size and the user keeps ignoring the low memory warnings
in the console, the NVIDIA driver may cause Viz Engine to crash.

* The NVIDIA driver doesn't recognize other GPUs under certain circumstances in combination with video wall
mosaic installations. Remove and reinstall the driver.

1.5.17 Graphic Hub

e Communication with the Graphic Hub Server might fail if virtual network adapters are active. Please disable
all virtual adapters or increase the timeout.
e |f the connection to the naming server fails, please verify the communication port in the config file (Port
19396 ).

1.5.18 Adaptive Scene Design

* WindowMask plug-in prevents Flexbox labels from being picked.
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1.5.19 Audio

* Unplugging a USB microphone from the machine while EAS is enabled freezes Viz Engine without the
possibility to recover (VIZENG-29571).

1.6 Supported Hardware and Software
This software has been tested to run on:

e Windows 11 (LTSC 2402)

e Windows 10 (LTSC 21H2) & (LTSC 1809)1)
e Windows Server 2025, Windows Server 2022

() Ynreal Engine requires a newer Windows 10 version than 1809. UE Integration was successfully tested with 21H2

Note: Only English language Operating System(s) are supported.

1.6.1 Supported Systems

System

Lenovo P3 Ultra
Lenovo P620
Lenovo SR655 V3
DELL R7920

HP Z8 G5 Fury
HP Z8 G4

HP Z4 Rack G5
HP Z4 G4

HP ZCentral 4R
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1.6.2 Supported GPUs

Ada Lovelace
GPUs

RTX 6000 Ada

RTX 5000 Ada

RTX 4500 Ada

RTX 4000 Ada

SFF

RTX 2000 Ada

Ampere
GPUs

RTX A6000

RTX A5500

RTX A5000

RTX A4500

RTX A4000

RTX A2000

RTX A3000

(mobile)

RTX A2000
(mobile)

RTX A1000
(mobile)

Turing
GPUs

RTX
6000

RTX
5000

RTX
4000

RTX
3000

T1000

1.6.3 Supported Video Boards

Video Board

Configuration

Matrox Electronic Systems Ltd

Volta

GPUs

GV100

Pascal
GPUs

Quadro
P6000

Quadro
P5200

Quadro
P4200

Quadro
P4000

Quadro
P3200

Quadro
P2200

Quadro
P2000

Quadro
P1000
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Maxwell
GPUs

Quadro
M6000

Quadro
M4000

Quadro
M2000

Kepler
GPus (1

Quadro
K6000

Quadro
K5000

Quadro
K5200

Quadro
K4000

Quadro
K4200

Quadro
K2000

Quadro
K2200
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Video Board

Matrox X.mio5/X2 SDI

Matrox X.mio5/8 SDI

Matrox X.mio5 IP

Matrox X.mio3 Full Height
Matrox X.mio3 12G

Matrox M.264 S1/S2/S3/
S4

Matrox DSX LE 5L /4
Matrox DSX LE 4 /8
Matrox DSX LE 4 /4
Matrox DSX LE 4 IP
BlueFish Technologies
Bluefish Epoch Neutron

Bluefish Epoch 4K
Supernova

Bluefish Epoch Supernova
S+

Bluefish Kronos K8
AJA Video Systems, Inc.
AJA 104K Plus

AJA Kona 4
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Configuration

Up to four 12G SDI input with up to four SDI 12G SDI outputs
variable configuration from 12inOout to Oin12out

Up to four 12G SDI input with up to four SDI 12G SDI outputs
variable configuration from 8inOout to Oin8out

Up to 32 ST 2110 inputs and 32 ST 2110 outputs depending on
used SFPs and resolution

Various input/output configurations from 48 to 84
Two 12G inputs, two 12G outputs

H.264 Encoder/Decoder board

Various input/output configurations from 04 to 40, all in 12G
Various input/output configurations from 08 to 80
Various input/output configurations from 04 to 40

Various input/output configurations from 04 to 40

Two video inputs, two video outputs (fill & key)

Two video inputs, two video outputs (fill & key)

Two video inputs, two video outputs (fill & key)

Four video inputs, two video outputs (fill & key)

Two video inputs, two video outputs (fill & key)

Two video inputs, two video outputs (fill & key)

Please refer to the Viz Engine Administrator Guide for which drivers and driver settings to use.
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2 VizEngine5.4.0

Release Date: 2025-08-28

These are the release notes for Viz Engine version 5.4.0. This document describes the user-visible changes that have
been made to the software since release 5.3.

Note: Viz Artist maintains its release notes in a separate document starting from version 3.12.0.

2.1 Installer Notes

2.1.1 General

The Software ships with a bundle installer containing all necessary components. It is recommended to use the
bundle installer when setup needs to be done manually.

¢ The Setup application (both MSI and Bundle installer) must be run in Administrator mode.

¢ Visual C++ Redistributable files are no longer part of the .msi setup file. These files are now installed with the
bundle setup application (VIZENG-13210, VIZENG-12629, VIZENG-12701).

* The bundle setup application installs or upgrades Viz Artist together with its required Visual C++
Redistributable files (VIZENG-12936, VIZENG-13804).

¢ Allfiles contained in the bundle setup application can be extracted using the /dump command line option.
This creates a sub-folder where the files are extracted (VIZENG-13020).

¢ Multiple installations of Viz Engine are not supported.

¢ Theinstaller automatically upgrades (replaces) any existing Viz Artist/Viz Engine 3.x installation. However,
downgrading is currently not supported (VIZENG-7098).

¢ |f Adobe After Effects is installed after Viz Engine, the Viz installer needs to be executed again to install the AE
plug-in (VIZENG-7876).

® The user account must have SeCreateGlobalPrivilege (SE_CREATE_GLOBAL_NAME) enabled.

* The configuration profiles shipped with Viz Engine guarantee a correct Audio/Video delay, to have a proper
lip-sync setup or a correct video wall installation. A manual configuration (for example, number of inputs,
clips, etc.) is still required, after applying these profiles (VIZENG-18861).

® To use Global Illumination in Viz Artist/Viz Engine, at least Direct X version 9 is required. An installer can be
found at https://www.microsoft.com/en-us/download/details.aspx?id=8109 (VIZENG-19983).

¢ Download the DirectX End-User Runtimes (June 2010):

¢ Microsoft Download Link: https://www.microsoft.com/en-us/download/details.aspx?
id=8109&msockid=0b138cclab106ech24dh9a58a...

¢ Extract the files:

¢ Runthe downloaded .exe and select afolder for extraction.

¢ After extraction, navigate to that folder and run DXSETUP.exe .
¢ Complete the installation:
¢ Thisinstalls all missing legacy DLLs, including d3dx9_43.d11.
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* The Basic, Viz DataPool, Viz PixelFX, Viz Maps, Viz Extension and Viz Socialize plug-ins are released together
with Viz Engine, starting with version 4.0.0, and are included in the bundle installer. The basic plug-ins are
installed by default.

Note: In case of installing Viz Engine with the individual MSI installer and not the Viz Artist Bundle installer,
ensure all runtime dependencies are up-to-date (for example, Viz Engine does not start with an outdated
Microsoft Visual C++2015-2022 Redistributable (x64) version). The minimum required version is
14.40.33810 (https://aka.ms/vs/17/release/vc_redist.x64.exe).

If Microsoft Visual C++2015-2022 Redistributable (x64) - 14.40.33810 is already installed and Viz Engine is
not starting, the runtime installation could be damaged. Reinstall the runtime redistributable in this case.
The related installer is part of the Bundle installer.

0 Information: In case of upgrading from previously installed versions, and the upgraded version comes
with a new CodeMeter version, make sure that all the applications installed using CodeMeter on the same
host, are still running.

2.1.2 Windows

¢ This software was tested to run on Windows 11 (LTSC 24H2), Windows 10 (LTSC 1809, 21H2) and Server 2019
and Server 2022.

¢ Windows transparency effects should be turned off (former known as Aero). In Windows 10 set Show
transparency in Windows to Off in Settings > Display and Transparency effectsto Off in Settings >
Personalization > Colors > More options.

* Power management and hibernation mode must be turned off under Windows. You can execute

powercfg —-h off toremove hiberfil.sys from the hard disk.

e |tisrecommended to install the latest Windows Security Updates and Patches, except NVIDIA updates.

Installations on Windows 10 are only supported on their respective supported hardware (see Supported

Systems).

.NET framework 4.5 or higher is required (VIZENG-6036).

¢ The minimum Windows Installer version is now 5.0.0 (VIZENG-10146).

To run Viz Engine without Administrator privileges, you need to grant the following permissions:

® SelncreaseBasePriorityPrivilege
e SeCreateGlobalPrivilege

* SeCreatePagefilePrivilege

® SelncreaseWorkingSetPrivilege

2.1.3 UAC

¢ iz Engine is UAC aware. Configuration files, profiles, log files, and additional files are stored in
%VIZ_PROGRAMDATA%, which defaults to %ProgramData%)\Vizrt\VizEngine. Temporary data is stored in
%VIZ_TEMPDATA% which defaults to %TMP%\Vizrt\VizEngine. The default value can be changed in the
command line of viz.exe.

¢ Existing Lens files are copied from %ProgramfFiles% install folder to the new UAC
aware %ProgramData% folder during installation (VIZENG-8757).
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* Existing Viz configuration files are copied from %ProgramFiles% install folder to the new UAC aware
%ProgramData% folder during installation (VIZENG-7472).

2.1.4 Cinema4D

¢ Cinema 4D LivelLink Installation: The installer searches the following location first: %ProgramfFiles%
\MAXON\CINEMA 4D R16\plugins (VIZENG-7965).

* Cinema 4D LiveLink package can be installed any time later by using Viz Artist Installer in Repair mode. Its
installation folder is not selectable anymore (VIZENG-8996).

® Cinema 4D R23 or newer: LiveLink plug-in is available at %ProgramFiles%\Vizrt\VizEngine\CINEMA 4D
LiveLink\R23 (VIZENG-25344).

2.2 Driver Versions

These are the recommended driver versions for various hardware components:

Vendor Driver Version

NVIDIA Blackwell, Ada Lovelace, Ampere, Turing, 572.83
Volta, Pascal and Maxwell GPUs

NVIDIA Kepler GPUs 473.47 (419.17 for older boards)
Matrox Topology based boards 11.1.101.2163

Bluefish 6.5.1.22

Bluefish Supernova Firmware 162

AJA 16.1.0.3 (Firmware 2021/06/23)
Codemeter Runtime Kit 8.30a

AV PCL/PCI Plura Timecode Reader 5.34

2.2.1 NVIDIA Drivers

o Information: Please refer to https://nvidia.custhelp.com/app/answers/detail/a_id/4777/~/nvidia-dch/
standard-display-drivers-for-windows-10-faq for information about the DCH and Standard driver versions
and how to install a missing NVIDIA control panel.

NVIDIA driver 572.83 is recommended for GPUs with Blackwell, Ada Lovelace Technology. Ampere, Turing, Volta,
Pascal or Maxwell Technology cards have been tested with 572.83 only. A driver upgrade is not recommended in
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general. Kepler GPUs are not recommended anymore, however they might still work using older driver version
473.47. Boards that do not support this version of the driver should use rev. 419.17.

NVIDIA Driver Configuration (Manage 3D Settings):

Setting
Vertical sync
Unified Back Buffer

Power management
mode

Antialiasing mode
Antialiasing setting

Profile

Force Off (except Videowall and systems without video hardware).
Off

Prefer maximum performance

Enhance the application setting
4x (4xMS)

Workstation App - Dynamic Streaming profile (for systems with video
hardware)
3D App - Video Editing (for systems without video hardware)

€ Important: Viz Engine will not start if an outdated driver is used.

2.2.2 Matrox Drivers

® For Matrox video cards, driver version 11.1.101.2163 is required. This version is mandatory. Pre-release
versions are not supported.

¢ Uninstall previous versions of Matrox DSXUtils prior to installing this driver.

e Install drivers (DSX-TopologyUtils.exe) only from a local drive.

® Reboot between uninstall and install of drivers, and another time after the installation has finished.

¢ The VfW codecs are included in this driver, so uninstall previous versions of the Matrox VfW codecs and do
not install any Matrox VfW codecs over the regular driver installation.

2.2.3 Other Drivers

® The latest firmware for Supernova and Supernova S+ is 162.

The latest firmware for Neutron is 1i20 35. There is no longer linlout firmware.

® The recommended firmware for AJA |04K+ devices is 2021/06/23.
¢ The recommended driver version for Plura AV timecode reader cards is 5.34.

Please refer to the Viz Engine Administrator Guide for which drivers and driver settings to use.

Given that a supported Matrox device is installed, the following codecs are supported for post-rendering with
MatroxFileWriter and the ClipOut channels:

¢ RLE (animation), playback only
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H.264

* Apple ProRes

e HDV

e XDCam

* DVCPro

e DNxHD (4849)

® XAVC (UHD requires M264 board)

2.3 Upgrade Notes

¢ All plug-in installers are installed per-machine starting with 5.2.0. Uninstalling all previous per-user plug-in
installations before upgrading is recommended to avoid duplicated installer entries.

® Existing Viz 3 configuration files, Genlock and IP configuration settings are migrated automatically by Viz
Engine.

® The old Shared Memory output is not supported on the Viz Engine Pipeline.

® Due to changes in the video 10 part, ring buffer size for interlaced virtual studio setups might require a higher
ring buffer setting. Existing configuration file(s) might need to be adapted.

® Scenes using the BrowserCEF plug-in automatically migrate to use the new Browser plug-in.

* The command interface is not locale-aware. Special regional settings like a semicolon within float numbers

do not work. You need to use a regular ".

0 Information: Viz Engine is not forward-compatible. Opening scenes created in this version of Viz Engine
might drop warnings when opening in previous versions. A scene saved with this version might look
different if you open it in a previous version. This affects scenes containing more than four streaming
channels.

2.3.1 Licensing Model

¢ The CodeMeter Runtime (installed with the bundle installer) is required to use the WIBU license system.
Details can be found in the manual in section "WIBU-based Licensing System". Please refer to the Vizrt
Licensing documentation on how to apply a license container.

¢ Cloud-based installations require a license server; standalone cloud installations are not supported.

2.3.2 Other Upgrade Notes

NVIDIA Tesla Grid K2 Support was removed because no up-to-date drivers are available anymore.
e Viz Engine does not support half-height rendering anymore.
Lens distortion uses a slightly different norm since revision 54263. If you need older lens files, please

use use_lens_compatibility_mode = 1 inthe configfile.

Viz Artist is now being started by the Viz Engine process and not by command file anymore. If you
start viz.exe and VizGui.exe independently, the Restart Current option fails.

A 64-bit version of each codec must be installed to work with Softclip64. Most codecs come with an installation
manual on how to install them correctly.
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Softclip64 has been tested to work with the following 64-bit codecs:

¢ HuvYuff Version 2.1.1
¢ Lagarith Version 1.3.27
¢ Newtek SpeedHQ

2.4 Virtual Environments

The following GPUs have been tested in virtualized environments, the listed driver version is the one being used.
The following GPUs are currently supported (Kepler are only supported in the Classic Render Pipeline):

Model Driver Platform

NVIDIA L4 573.07 AWS (g6 instances, gr6 instances)
NVIDIA A10G 573.07 AWS (g5 instances)

NVIDIA T4 Tensor Core 573.07 AWS (g4dn instances)

NVIDIA Tesla V100 431.79 GRID9.1 AWS (p3 instances) (V)

NVIDIA A40 @ 572.60 vSphere 7.0 and 8.0

NVIDIA RTX6000 572.60 vSphere 7.0 and 8.0

(@) 1nstance not supported on Windows Server 2025 or higher (legacy uefi boot).

Viz Engine has been tested to run in the following virtual environments:

Viz Engine Render Pipeline Classic Render Pipeline

Amazon Cloud (AWS)

® Amazon EC2 G5 Instances
e Amazon EC2 G4dn Instances

000

® Amazon EC2 G3 Instances

Microsoft Azure (1)

e Standard_NCv3 Series

/]
e Standard NV Series °

fra.me/nutanix (N not tested ()
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Viz Engine Render Pipeline Classic Render Pipeline

VMWare ESXi (6.0(1, 6.50(1, 7.02, o

8.0.2)

Alibaba Cloud (I

not tested

(1) Tested with Engine 5.0.0 only

A\ Note: Backup and Restore on Azure systems are currently not supported.

2.5 New Features

2.5.1

Key
VIZPL-2077
VIZENG-33564
VIZENG-32805
VIZENG-32601
VIZENG-32440
VIZENG-32373
VIZENG-32368
VIZENG-32367
VIZENG-32362
VIZENG-32337
VIZENG-32328
VIZENG-31986

VIZENG-31796

Key Features

Summary

VizEngine-5.4.0 - Support Maxar Geospatial Platform (MGP) Pro in Atlas Plugin

VizEngine-5.4.0 - Renderer Improvements
VizEngine-5.4.0 - Stylesheets

VizEngine-5.4.0 - Security efforts

VizEngine-5.4.0 - I/O Features and Improvements
VizEngine-5.4.0 - Particle Systems to emit Geometries
VizEngine-5.4.0 - Move to Online Documentation
VizEngine-5.4.0 - Parallel Outputs Scene Support
VizEngine-5.4.0 - Flowics / HTML Media Asset
VizEngine-5.4.0 - NDI 6.2 Support

VizEngine-5.4.0 - Adaptive Support for TL
VizEngine-5.4.0 - WebRTC Improvements

VizEngine-5.4.0 - Clip Player Improvements and Fixes
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Key

VIZENG-31563
VIZENG-31520
VIZENG-31519
VIZENG-31257
VIZENG-31184
VIZENG-31181

VIZENG-28795

20 issues
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Summary

VizEngine-5.4.0 - Viz Engine Renderer Extrusions

VizEngine-5.4.0 - Viz Engine Renderer Sports Sequences - Stage 3 / Complete Libero Workflow
VizEngine-5.4.0 - Full HDR pipeline

VizEngine-5.4.0 - Videowall Large Canvas Support

VizEngine-5.4.0 - Artist for Learners Support Preparation

VizEngine-5.4.0 - Turn off Classic Pipeline configuration

VizEngine-5.4.0 - Adaptive Storytelling Additions

2.5.2 New Features: General

Key

VIZENG-32355

VIZENG-31750

VIZENG-33824

VIZENG-32683

VIZENG-32806

VIZENG-33723

VIZENG-33401

VIZENG-33759

VIZENG-32682

VIZENG-33537

VIZENG-32700

VIZENG-30817

Summary

Adaptive Graphics GFX Channel Flexbox Support

Add "ImportTask" support forimages

Add assign colorspace and linearize/apply_tf to texture_image_compat
Add event handling for WebChannels in DVE mode

Add stylesheet functionality

Add support for RTX 2000 Ada

Add white level to HDR settings

Allow webchannels to be used within superchannels

Disable classic pipeline for Artist for Learners

Ensure stable fps for Video Wall setups with the renderer always in front
Expose priority of Function Plugins to user, let them rearrange manually

Handle <uuid>*NAME GET command, without loading the object
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VIZENG-33773
VIZENG-31297
VIZENG-33839
VIZENG-31854
VIZENG-33667
VIZENG-33749
VIZENG-32794
VIZENG-32728
VIZENG-33333
VIZENG-33619
VIZENG-32329
VIZENG-31272

VIZENG-32330
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Summary

Image colorimetry attribute

Increase the zoom out inside the stage

OnAirFormat needs to be considered while setting scene on RENDERER.
One of the horizontal bar in Stage is almost invisible

PERFORMANCE SET_VALUES add styling values

RTX PRO 6000 Blackwell Support

Searching for Particle Systems returns wrong result

Show Main Axis and Cross Axis direction in the bounding box of Flexbox
Stylesheet: add per format style selection support

Stylesheet: investigate and fix issues exposed in VIZART-5340

Support BoxTransformation/Flexbox in Toggle Plugin

Support for GET GH Name info via REST

Toggle Plugin: Support formats

2.5.3 New Features: Renderer

Key

VIZENG-32516
VIZENG-31750
VIZENG-32541
VIZENG-32774
VIZENG-33675

VIZENG-32648

Summary

Add "browser" channel type

Add "ImportTask" support for images

Add animation support to DynamicGeometry and its nodes
Add AuxDepth support to Multilayer External VS sequence.

Add ColorEncoding to SceneGlobals for better Artist integration

Add DVE support to Webchannel
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Key

VIZENG-32644

VIZENG-31547

VIZENG-33278

VIZENG-32263

VIZENG-32806

VIZENG-32178

VIZENG-33370

VIZENG-32576

VIZENG-32582

VIZENG-33401

VIZENG-33639

VIZENG-32381

VIZENG-33164

VIZENG-33402

VIZENG-32701

VIZENG-33471

VIZENG-33616

VIZENG-33838

VIZENG-33713

VIZENG-33714

VIZENG-33817

VIZENG-32557

VIZENG-32482

Viz Engine Release Notes - 5.4

Summary

Add DynamicGeometry node addition and removal

Add FBX Blend Shape support on dynamic geometries

Add HDR setting to Viz Engine Renderer scenes

Add instancing Plugin API support for the instancing producer
Add stylesheet functionality

Add support for BGR and BGRA image scaling

Add support for LUTs to convert between colorspaces

Add support for whitespace paths on Viz Engine's Unreal project directories
Add Ul support for DynamicGeometryNode

Add white level to HDR settings

Alembic support in Viz Engine Renderer

Alternative light falloff option

Browser Plugin / Web Media Asset video playback support

Convert assets (images) according to different HDR settings (colorspace, transferfunction,
whitelevel)

DynamicGeometry: Create a Plugin node

DynamicGeometry: Make BlendShape node a generator

HDR: convert HDR to scRGB when presenting

HDR: load and dynamic range convert images from disk via texture image
HDR: LookupTable conversion on non-keyed areas

HDR: snapshot rendering in 16bit

HDR: support automatic colorspace conversion on TEXTURE_IMAGE
Implement a DynamicGeometryNode for calculating normals

Implement a GPU DynamicGeometryNode
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Key

VIZENG-32550

VIZENG-32316

VIZENG-33560

VIZENG-33410

VIZENG-33392

VIZENG-33628

VIZENG-32580

VIZENG-32288

VIZENG-31493

VIZENG-33388

VIZENG-32305

VIZENG-33281

VIZENG-32441

VIZENG-33702

VIZENG-32818

VIZENG-31909

VIZENG-33669

VIZENG-31156

VIZENG-32325

VIZENG-33412

VIZENG-32890

VIZENG-28969

VIZENG-28973

Viz Engine Release Notes - 5.4

Summary

Implement BlendShapes on a compute shader

Implement GeometryModifier

Implement Tetrahedral Interpolation for LUTs

Improve DynamicGeometry Twist node

Improve text extrusion and effect performance and behavior
lensDistortion texture is not available for multilayer sequences
Make AbstractGeometry publicly available for artist

Make particle system compatible with instancing Plugin API
Modify FBX importer to create static geometries by default
Preliminary Clipping planes functionality on Unreal

Proper support of Unreal in HDR workflow

Reduce Unreal Engine Plugin size after Reality Connect additions
Renderer: disable attachments that are not needed

Renderer: replace isSRGB with linearizeMethod in TextureSlot
Renderer: support composition for Al Keyer use case
Renderer: support hot-reloading materials when GH changes
Renderer: support Khronos PBR neutral tonemapper
Renderer: support lens distortion

Support "Magnifier" in Viz Engine Renderer

Support copying DynamicGeometry animations

Support DynamicGeometryPluginNode animations

Support Fill&Key in the Libero render sequence

Support Glow in the new Viz Engine renderer

Copyright © 2025 Vizrt

Page 33


https://vizrt.atlassian.net/browse/VIZENG-32550
https://vizrt.atlassian.net/browse/VIZENG-32550
https://vizrt.atlassian.net/browse/VIZENG-32316
https://vizrt.atlassian.net/browse/VIZENG-32316
https://vizrt.atlassian.net/browse/VIZENG-33560
https://vizrt.atlassian.net/browse/VIZENG-33560
https://vizrt.atlassian.net/browse/VIZENG-33410
https://vizrt.atlassian.net/browse/VIZENG-33410
https://vizrt.atlassian.net/browse/VIZENG-33392
https://vizrt.atlassian.net/browse/VIZENG-33392
https://vizrt.atlassian.net/browse/VIZENG-33628
https://vizrt.atlassian.net/browse/VIZENG-33628
https://vizrt.atlassian.net/browse/VIZENG-32580
https://vizrt.atlassian.net/browse/VIZENG-32580
https://vizrt.atlassian.net/browse/VIZENG-32288
https://vizrt.atlassian.net/browse/VIZENG-32288
https://vizrt.atlassian.net/browse/VIZENG-31493
https://vizrt.atlassian.net/browse/VIZENG-31493
https://vizrt.atlassian.net/browse/VIZENG-33388
https://vizrt.atlassian.net/browse/VIZENG-33388
https://vizrt.atlassian.net/browse/VIZENG-32305
https://vizrt.atlassian.net/browse/VIZENG-32305
https://vizrt.atlassian.net/browse/VIZENG-33281
https://vizrt.atlassian.net/browse/VIZENG-33281
https://vizrt.atlassian.net/browse/VIZENG-32441
https://vizrt.atlassian.net/browse/VIZENG-32441
https://vizrt.atlassian.net/browse/VIZENG-33702
https://vizrt.atlassian.net/browse/VIZENG-33702
https://vizrt.atlassian.net/browse/VIZENG-32818
https://vizrt.atlassian.net/browse/VIZENG-32818
https://vizrt.atlassian.net/browse/VIZENG-31909
https://vizrt.atlassian.net/browse/VIZENG-31909
https://vizrt.atlassian.net/browse/VIZENG-33669
https://vizrt.atlassian.net/browse/VIZENG-33669
https://vizrt.atlassian.net/browse/VIZENG-31156
https://vizrt.atlassian.net/browse/VIZENG-31156
https://vizrt.atlassian.net/browse/VIZENG-32325
https://vizrt.atlassian.net/browse/VIZENG-32325
https://vizrt.atlassian.net/browse/VIZENG-33412
https://vizrt.atlassian.net/browse/VIZENG-33412
https://vizrt.atlassian.net/browse/VIZENG-32890
https://vizrt.atlassian.net/browse/VIZENG-32890
https://vizrt.atlassian.net/browse/VIZENG-28969
https://vizrt.atlassian.net/browse/VIZENG-28969
https://vizrt.atlassian.net/browse/VIZENG-28973
https://vizrt.atlassian.net/browse/VIZENG-28973

Key

VIZENG-33586
VIZENG-28968
VIZENG-31405
VIZENG-32533
VIZENG-32273
VIZENG-33208
VIZENG-31401

VIZENG-31229

60 issues

Viz Engine Release Notes - 5.4

Summary

Support HDR inputs in classic scenes

Support SplineStrip Plugin in Viz Engine Renderer

Texture Desaturation

Trash Matte does not affect to the container with Talent Shadows
Unreal Engine 5.5 Support

Unreal: Controllmage does not load images from URLs

Update DLSS to 3.7.20

Use glm in indexed_mesh

2.5.4 New Features: Video 10

Key

VIZENG-33907

VIZENG-33834

VIZENG-33531

VIZENG-33530

VIZENG-33528

VIZENG-33525

VIZENG-33480

VIZENG-33407

VIZENG-33405

VIZENG-33378

VIZENG-33377

Summary

Move plura card timecodes to more consistent TC index

HDR: support hdr engine mode independently from installed / used video board
Integrate newly exposed license APl into VizEngine

Integrate the new VCP into VizEngine build

Clip player flag to force the player only to use Matrox

Enable Matrox SDI/IP video output from GFX channels

New parallel output configuration requires new config preset

Add support for reading metadata from audio files

FFmpeg 7.1.1 zlib/openssl/curl Fixes

Update curl

Update xerces
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Key

VIZENG-33347
VIZENG-33341
VIZENG-33284
VIZENG-33282
VIZENG-33271
VIZENG-33240
VIZENG-33164
VIZENG-32906
VIZENG-32792
VIZENG-32695
VIZENG-32693
VIZENG-32689
VIZENG-32538
VIZENG-32487
VIZENG-32313
VIZENG-31615
VIZENG-31148

VIZENG-30876

29 issues

Viz Engine Release Notes - 5.4

Summary

Implement Shot Clock data extraction from VANC data

Support Type Il LUTs

Frame Rate Derivation in Compound Input and avformat:

Sync Colorspace Definitions with ffmpeg 7.1.1

Cleanup Use of AVPacket

Integrate FFMpeg 7.1.1 into clip player

Browser Plugin / Web Media Asset video playback support
Decouple MapToVizChannel from Matrox configuration

Add 8K and 8K+ resolution licenses

Enable UHD2 resolutions for VizEngine

Integrade DSX LE6 D100

Multiplay transition not working with VML clip player

Align parameter order of Matrox config pages between Artist and Engine
Matrox Clip Player optimizations for clip frame accurate playback
NVDEC support for Clip Texture Renderer

Upgrade OpenSSL version in VML Clip Player to 3.5.0

Allow multiple outputs from a large canvas

Alpha support for WEBM with VP8/VP9 and MKV with VP8/VP9
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Viz Engine Release Notes - 5.4

2.6 Fixed Issues

2.6.1 Fixed Issues: General

Key

VIZENG-33947

VIZENG-33833

VIZENG-33798

VIZENG-33516

VIZENG-33479

VIZENG-33453

VIZENG-33255

VIZENG-33251

VIZENG-33238

VIZENG-33228

VIZENG-33153

VIZENG-32940

VIZENG-32899

VIZENG-32796

VIZENG-32772

VIZENG-32681

VIZENG-32639

VIZENG-32628

VIZENG-32617

Summary

Control SoftClip isn't added inside the Control Objects

get_renderoption_force_sleep has no effect

True becomes False in VSL

Viz Engine crash related to format dependent animations

Engine crash related to Arraylndex error in script

DVE size does not match the size of the tracked container

Superchannel XY center doesn't apply to a tracked object

DVE placeholder isn't visible when scene is loaded in the Front or Back layer

Clip gets flushed after GoTo Trio command

Control channel Move command doesn't work as argument

GET_PEER_INFO still shows clients which aren't connected to the Viz Engine anymore
Reconnection of a Viz Engine to the GH in case of a cluster failover takes up to two minutes

ESC key or CTRL + BACKSPACE doesn't work in conjunction with Navigator and/or 3DLineTracer
Plugins

Alpha gets ignored when importing .tiff image with alpha

Custom shader Plugin isn't merged under the same geometry director inside stage
Loading objects from UNC path switches "\" to "/" which causes a failure

Text Kerning can lead to issues in animation

Engine REST - POST commands return "Parse Error: The response has a duplicate "Content-
Length" header

Script function OnGeometryChanged doesn't work properly in Viz Engine Renderer
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Key

VIZENG-32606
VIZENG-32571
VIZENG-32438
VIZENG-31969
VIZENG-31867

VIZENG-31610

25 issues

Viz Engine Release Notes - 5.4

Summary

Scripting function This.Geometry.Orientation doesn't work in Viz Engine Renderer
Ability to select font family + variant without text

Wrong command format for SYSTEM*MEMORY_ADVANCE GET

Wrong distortion in the Unreal Engine Composite mesh with Stype distortion mode
Internal image editor wrongly scale RGBA image

Scaling a parent director ruins child directors with offsets (time displace)

2.6.2 Fixed Issues: Renderer

Key

VIZENG-339
00

VIZENG-338
71

VIZENG-335
05

VIZENG-334
55

VIZENG-333
96

VIZENG-333
40

VIZENG-333
01

VIZENG-332
74

VIZENG-332
64

Summary

HDR: external ar double-lutted when color_lut_enabled is setto 1

HDR: hlg composition wrong with alpha

Center Shift doesn't affect Unreal Engine Planar Reflection

Nvidia TDR error with VER scenes in wall setup - MERGE 5.3.2

Mixing Depth Buffers doesn't work in Multi-Layer Virtual Studio render sequence

Preview Engine Crash : Nvidia OpenGL Driver TDR has been detected. Error Code 7

Viz Engine crashes when selecting light probes inside Global Ilumination

Transition Logic broken, Animations not copied properly

The Degree ° symbol Passed to Unreal through VizControlText is coming with wrong coding.
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Key

VIZENG-332
61

VIZENG-332
02

VIZENG-331
92

VIZENG-331
87

VIZENG-329
76

VIZENG-329
69

VIZENG-328
16

VIZENG-327
38

VIZENG-326
70

VIZENG-326
62

VIZENG-326
56

VIZENG-326
17

VIZENG-326
16

VIZENG-326
06

VIZENG-325
93

VIZENG-324
74
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Summary

TransitionLogic scene not working with TransitionLogicUseMergedGeometries =0

Issue with invalid data passed to Enlighten

Enable/disable the Expert Plugin

Unreal: Controlimage does not load images from URLs

CallFunc_GetCompositeWorldData_ReturnValUnreal Engine error messages in Unreal Engine

Editor when project is started with "selected viewport"

Nvidia TDR error with VER scenes in wall setup

EUBP_CompositorActorHelpers error inside Unreal

Font flickers if Classic material is on the same container

Unreal VDB doesn't work with Composite Mesh

Layer Plugin loses its settings when merge/split into a geometry

Center shift doesn't affect Unreal Engine planar reflection (UE5.5)

Script function OnGeometryChanged doesn't work properly in Viz Engine Renderer

Text overlapping when using Razor text in texture mode

Scripting function This.Geometry.Orientation doesn't work in Viz Engine Renderer

Vertex Colors not working with Complex Polygon

OPENGL error when loading a scene in SHM Out mode
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Key

VIZENG-324
15

VIZENG-322
66

VIZENG-320
15

VIZENG-319
69

29 issues
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Summary

Render Scale affects to the Background AUX from Unreal Engine with Composite mesh.

Material Shininess wrong in sample scene after Scene Conversion

Dynamic Scene Plugin with Viz World scene - Abnormal behavior

Wrong distortion in the Unreal Engine Composite mesh with Stype distortion mode

2.6.3 Fixed Issues: Video |10

Key

VIZENG-33693

VIZENG-33546

VIZENG-33522

VIZENG-33498

VIZENG-33483

VIZENG-33408

VIZENG-33287

VIZENG-33258

VIZENG-33238

VIZENG-32841

VIZENG-32821

VIZENG-32646

VIZENG-32596

VIZENG-32474

Summary

Closed Caption extraction is shared via the GraphicHub

Captioning issues on DVE passthrough

Matrox Clip Player crashes with ProRes clip and frame converter
Matrox Clip Player crashes with ProRes clip

Xmio3 Clip player play after stop shows black frames

Matrox clipplayer skips 1 frame on continue

Clips randomly loop if the wrong clip player receives the loop command
Matrox: Artifacts during DVE animations on X.mio5

Clip gets flushed after GoTo Trio command

Clip channel with alpha enabled causes pink strip inside the clip
Engine does not extract special characters in Closed Caption workflow
Matrox Output not fitting the card number for Xmio 5/8/

Prevent input delay of 0 frames

OPENGL error when loading a scene in SHM Out mode
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Key Summary
VIZENG-32278 Matrox: Video Cue and Playback issue with specific OP1a video
VIZENG-31795 Clip inside the stage can only be played once with Matrox clip player
VIZENG-31191 Short freeze on Matrox output

17 issues

2.7 Changes

2.7.1 Upcoming Changes

¢ In the next version of Viz Engine, an upgrade to VGPU 17 is planned. Therefore:
¢ NVIDIA Tesla M60 VGPU support will be removed.
* Windows Server 2019 VGPU support will be removed.

¢ In the next version of Viz Engine, support for SNMP will be completely removed.

2.7.2 Changes: Renderer

* NVIDIA Kepler GPUs were set as deprecated (NVIDIA isn't supporting Kepler boards in newer driver versions
anymore).

¢ The final position and size of scaled image channels in DVE mode might change by 1 pixel after fixing
rounding issues.

2.7.3 Changes: VideolO

® Improvements in the 10 sequence made GPU direct obsolete. The setting was removed.
e Support for SMPTE ST 2022-6 was removed in previous versions.

Note: X.mio3 IP is no longer supported. Matrox dropped the support in the latest 11.x driver versions.

Note: The Matrox channel mapping format has been updated in the configuration file. Old config files are
migrated automatically during startup.
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2.8

Known Issues

2.8.1 General

Key

Saving a new scene with references that do not exist anymore fails. Those references need to be removed
manually to save the scene.

Importing HDR images with special characters in its file name from a drive with 8dot3 disabled fails.
Transition Logic scenes require to have GeomAutoFree = 1 set in the Viz Config file. With inactive
GeomAutoFree, system stability is not guaranteed.

Interactive Applications within a GFX channel only work in DVE mode in Fullscreen or if the GFX channel has
an offset in Fullscreen. Scaled GFX channels or plug-ins that rely on screen coordinates (Graffiti) are not
supported.

Bones and Skin live motion data tracking requires Tracking Hub 1.1.2 (released together with Viz Engine
3.11).

Viz Engine REST interface does not start if a user is Non-Admin (VIZENG-23386).

On Air output shows wrong field-of-view if AuxRenderer is enabled, PP in scene editor is disabled and Viz
Engine is not in On Air mode.

Viz One Browser clip preview might fail on Viz One Versions >=7.0

The Toggle plug-in can not handle the background loading of objects or scenes.

Oversized snapshot requests (bigger than the configured output resolution) in the Classic Render Pipeline
aren't supported. Use the Viz Engine Render Pipeline instead.

The clog command now includes all child processes. Upon abnormal end, all child processes are
terminated before a restart is attempted (VIZENG-11361).

SNMP is deprecated by Microsoft. To use SNMP with Viz Engine 5.4.0, SNMP and VBScript must be manually
installed as Windows Components before installing the Viz Engine. See also Upcoming Changes.

Scaling directors down can cause keyframes to be scaled down to 0.0. These values do not recover when
scaling directors up again afterwards (VIZENG-31610).

Summary

VIZENG-34277  [MIGRATION] Text fgColor keyframes not preserved when 3.14.5 scene is opened in 5.4

VIZENG-27515  AJA10: Embedded Audio only available if SDI Input enabled

VIZENG-33562  Allow round-trip conversion between dynamic and static geometries

VIZENG-34094  animation for Sub Scene jumps from one director to another

VIZENG-32623  Assets flicker on video wall system

VIZENG-29680  Change Audio Backend on EAS

VIZENG-32400  Changing Spline types is not considered in Undo/Redo
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VIZENG-31745
VIZENG-28452
VIZENG-27866
VIZENG-31127
VIZENG-28344
VIZENG-33515
VIZENG-30569
VIZENG-24017
VIZENG-29589
VIZENG-31624
VIZENG-33414
VIZENG-31946
VIZENG-34209
VIZENG-32399
VIZENG-29623
VIZENG-34267
VIZENG-26964
VIZENG-33601

VIZENG-34221

26 issues

2.8.2

Viz Engine Release Notes - 5.4

Summary

Consider Gamma Correction in Material Definition Icon Generation
Consolidation of logging settings and configuration

Enable individual volume control for tracks

Experimental: Reduce overall in-to-out delay in Fast Texture Mode

GH Sync: support main/replication setup

Importing multiple AE scenes at the same time fails

Improve Undo/Redo performance on larger Gl scenes

Improve VizEngine startup time

Maya 2024 doesn't support Viz Maya plugin

Optimize transform update

Renderer: DVE placeholder not visible in Front or Back layer

Renderer: opaque materials affects key in overlay sequence

Scene with ezJavascript plugin crashes when used inside a GFX channel
Stop/Pause/Tags are not considered in Undo/Redo

Text: global config for default font style

TNT Project crash in Editor mode after 20-24h

Used lens distortion parameters not in sync with main scene

VizEngine does not always switch back to GH main after main shutdown and startup

Wall engine running with FULLSCREEN 59.94Hz runs at 50Hz in Software 1/0 mode

Installation

* Do not use the C4D Version 15R2 patch file(s) unless you are using this version. Otherwise, it prevents
Cinema 4D R16 from starting up.
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¢ When uninstalling Viz Engine, the installer might report that links could not be removed. Please check that
none of the desktop.ini files of Windows have write protection. For example, Skype seems to change the
permissions of some desktop.ini files with every update.

2.8.3 Windows 10

* Right-clicking on the Taskbar icon of Viz Engine starts a new instance. Starting an additional VizGui process
is prevented on Windows 10.

* Error message "Windows Media Player Rich Preview Handler has stopped working while opening specific
clips with Softclip x64". To fix open Windows Explorer > Tools > Folder options > View tab, and
deselect Show preview handlers in the preview pane.

2.8.4 Videowall

* |t might happen that Viz Engine is running at half speed on videowall, but goes back to full speed if another
window comes into focus. If so, start viz.exe -y -w,instead of the regular videowall mode viz.exe
-n -w.

¢ GFX channels with Alpha != 100% decrease render performance. On video wall setup,

gfx_channels_antialiased = 0 should be turned off in the Viz Configuration
section RENDER_OPTIONS.

e Windows scaling can lead to unwanted side effects.

® The maximum resolution on videowall setups is limited to 16392px by 16392px.

¢ Enabling video output for audio setups is not recommended for performance reasons. It is recommended to
grab the audio from one of the HDMI/DP outputs of the NVIDIA GPU and use an Audio embedder instead.

2.8.5 Configuration

¢ Specifying a path in the configuration file including the # character is not supported. Such paths are cut
before the # character.

2.8.6 VizEngine Render Pipeline

* Existing Scenes using Global Illumination might need a precompute again to enable debug views.

¢ Background loading of external images (filesystem, network locations, etc.) is not supported. Images from
Graphic Hub should be used.

* Flexbox labels in Scene Editor do not support Unicode characters.

2.8.7 Classic Render Pipeline

® Scene Transitions within GFX channels or Superchannels are not supported.

¢ Soft Shadow intensity is currently not working together with Global Illumination.

* We recommend using a warmup scene showing all needed assets once. Under certain circumstances, video
and clip surfaces can show up red the first time being used.
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Playing Audio clips on systems with no physical audio hardware available stops the renderer. You need to
turn off audio in the configuration file.

On some systems with hybrid graphics, like laptops, the dynamic swapping must be disabled in the BIOS
and the stronger GPU must be assigned as default.

Stencil-based shadows (Caster/Receiver) do not work on rotated geometry.

When changing CurlAuthUnsafe = 1,Viz One Browser does not work anymore.

VGA Fullscreen Output is only active if offscreen rendering is turned off. Setting offscreen=0 in
section RENDER_OPTIONS enables fullscreen output.

Blending cubemapped images are not supported.

Cubemapping with Browser plug-in is not supported.

Fonts need to be re-imported to use new Pathrendering or Razor fonts technology.

Masks are not supported on Path rendered Fonts (VIZENG-13737).

Do not send other commands than IS_RENDERER_READY and database connection commands before

this command returns 1 , otherwise the renderer and video output might not be initialized.
If you encounter stability issues with an NVIDIA driver or issues during driver installation, uninstall the old
NVIDIA driver completely, delete the folder C:\Program Files\NVIDIA Corporation\installer2, install the new
driver and select Custom installation, then check-mark the perform clean installation option and finish the
installation.
Enabling background loading might decrease the render performance by up to 15 frames per second. This is
due to OpenGL requirements.
M-Zone keyer only works with HD when rendering with full frames.
Decreased render performance in HD since Viz Engine 3.5.0 when the ringing filter is activated. Before Viz
Engine version 3.5.1 there was no ringing filter for HD. Turn off the ringing filter via configuration or scene-
setting to get the same performance.
Sporadic NVIDIA driver error The NVIDIA OpenGL driver lost connection with the display driver and is unable
to continue. which in turn causes Viz Engine to freeze. Make sure that the driver profile Workstation App >
Dynamic Streaming is selected. Always use the recommended NVIDIA driver for your GPU.
Possible performance problems with scenes imported from Viz Engine 2.x. Check the following settings
(applies to old 2.x scenes only):
* Image Combining should be set to Multi Texturing in the Render options in the configuration (or
flag combine_with_multitex = 1 inthe configuration file) to avoid inefficient image
combining.
¢ Set Key Render Mode to Single Pass in the rendering options in the configuration. The Key Render
Mode can also be set on scene level. Available options are:
* Config (inherit the setting from the configuration).
e Single Pass (fill and key are rendered in a single pass).
e Double Pass (fill and key are rendered in separate rendering passes).
Key rendering results differ between these options for compatibility reasons.
Use Single Pass scenes imported from Viz Engine 2.x and Double Pass for Viz Engine 3.x scenes.
The configuration flag exec_all_animations inthe section RENDER_OPTIONS should be setto 0 ifit
is not necessary to execute hidden animations.
Turn off the VGA preview in On Air mode to avoid performance drops due to multiple rendering of the scene
(applies only to video version of Viz Engine).
Hide containers that are not required for the current animation.
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® Re-import fonts directly with the Viz Engine.

¢ Grid picking currently only works for Cube and Cylinder geometry.

¢ The behavior of scripts with cyclic dependencies to other scripts is undefined. Avoid cyclic dependencies.

¢ Bad performance when using multiple dynamic scenes, even if they are set inactive. To avoid unnecessary
updates, change the Update mode in Dynamic Scenes to Auto instead of Always.

e CLR LOAD command can crash Viz if not used correctly. Required function signature: static int
pwzMethodName(String pwzArgument).

¢ Alpha setting for DVEs is not correctly supported when a scene is used nested using a GFX channel
(VIZENG-10212).

¢ Glow plug-in drops performance when used on multiple containers and rendered within a GFX channel or
viewport tile (Classic pipeline) (VIZENG-11342).

® Scene transitions do not work when dynamic images from different folders are involved. Dynamic images
always need to be stored directly in the root folder dynamic and references must point there. Dynamic
images in a subfolder of the dynamic folder or any other folder are not found.

* Font option "lighted" has no effect on fonts rendered with type "vector" (VIZENG-18941)

® 16-bit PNG images are not rendered properly when imported with compression.

2.8.8 UnrealIntegration

¢ Unreal Engine 5.x with Temporal Super Resolution (TSR) enabled can lead to flicker issues when used in
combination with NVIDIA Driver 528.89. Changing to FXAA solves the issue.
* Due to a technical limitation in Unreal Engine 5.6, this version is not yet supported by Vizrt Media Plugin.

2.8.9 Post Renderer

¢ Because of performance issues rendering fullscreen sequences in UHD is not supported.

* Ghosting effect in post-rendered interlaced video: Make sure that the Flicker Filteris setto © in the post-
rendering options of the Video Render plug-in.

¢ Post-rendering does not work properly if onair_no_videoout flag = 1 (Videowall mode).

e Post-rendering does not work properly if TriCaster integration is active and the output format is set to User
Defined or Fullscreen.

* DVCPRO expects 720x480 in NTSC resolution. Please set the correct output width in AVIRenderer.

® The alpha channel cannot be rendered with Intel Indeo 5.10 codec. This codec is not supported.

* Viz Engine might crash if certain VfW codecs are used on non-Matrox installations in Post Render Mode.

2.8.10 Matrox

Enable Hardware DVE/(Fast Texture Mode) is only available for two instances.

The configuration ClipIn[n].UseV210 and ClipIn1. ContainsAlpha are mutually exclusive and should not be
enabled at the same time.

The overall delay is one field higher than in previous versions using 103 This is caused by the required A/B
buffer of 10 4.

e A program output channel needs to be defined. Pure preview or Cleanfeed is not supported.

HDR output on UHD 2SI requires at least a Quadro P6000 GPU.
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Large Canvas setups require a RTX5000 Ada or higher.
Mixing different frame rates with clips processed by a M.264 board is not supported and causes jittering.
Upgrading the FPGA can cause a PCl error during the boot process on certain systems. Unattended
upgrading of the FPGA is not recommended.
Watchdog is only supported in 50/60M and 60Hz frequencies.
When using 3G formats (1080p/UHD) or the Zero-Frame-Delay Mixer, auto-sensing of the sync signal is not
supported due to incompatible H-/V-phases, that are set in the process.
Instead, either Tri-Level or Blackburst must be used together with correct H-/V-Phase. This might result in a
missing key signal (VIZENG-11708).
For dual channel systems, please perform the following steps after enabling the watchdog to ensure the
correct state is written to the Matrox Board:

a. Start Channel 1.

b. Wait until channel has started up and topology has been written.

c. Start Channel 2.

d. Wait until channel has started up and topology has been written.

e. Exit channel 2.

f. Exit channel 1.

g. Start channel 1.

h. Wait until channel has started up and topology has been written.
i. Start channel 2.

ClipOut channel does not work when Matrox0.VideoOutl.FrameBufferDelay is set to zero (VIZENG-16373).
UHD Clip Playback with M264 S1/S2/S3 alone requires color conversion on the shader level. (VIZENG-20700).
Two Sample Interleave (2SI) clips played as DVE are not supported.

Cutting of Audio tracks should not be done at all, as this results in a crackling noise. Always use a cross-fade
to change audio sources.

Monitoring live, clip and genlock status via SNMP is not supported (SNMP was deprecated and is no longer
supported by Microsoft).

Certain M4V clips may cause Viz Engine to lock and flood the console with errors when being played in a
loop.

Running interlaced AVC-Intra 100 clips on M.264 boards may lead to instabilities when played non-stop over
several hours.

Always verify the Destination Connector when changing/adding configurations of output channels.

2.8.11 X.mio3 Boards

If the Viz instance is closed unexpectedly, the X.mio3 topology might become unusable. To reset the
topology, enable ResetTopology in the config file, restart Viz, close it and start Viz again.

Turning on the Cleanfeed Feature increases the delay by one frame.

It is not recommended to change the frame group of any input signal while Viz Engine is running.

Only two DVE UHD inputs are supported at 50Hz. For 60M formats, only two texture inputs are supported.
Animating UHD DVE scaling might result in jittering. You need to increase the VideoDelayDVE settingto 2 .
Texture delay with PAL/NTSC, and Enable Hardware DVE is five fields instead of four fields. (VIZENG-16955).
When using watchdog together with a clean feed, the watchdog triggers on the clean feed connector rather
than the program output (VIZENG-16589).
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2.8.12 X.mio5 Boards

¢ Standard Definition (PAL and NTSC) resolutions are not supported by X.mio5 IP boards according to the
SMPTE ST 2110 standard.

¢ Streampunk ledger RDS does not list the Matrox X.mio5 nodes. This is due to some old NMOS APIs that are
partially deprecated.

* Riedel Explorer fails listing the X.mio5 nodes. Riedel Explorer automatically selects NMOS API Version 1.3
instead of 1.2. It is possible to select the used API version manually if you switch to static mode and/or
enable version downgrade in the Riedel Explorer.

The X.mio5 board has been tested to support up to 12 Inputs (1080i 50 and 60M) on a 10GbE network.

2.8.13 DSX.core

After the installation of the DSX-core client version of the driver perform the following steps:

1. Unregister mvfDsxCore.dll.

a. Click Start > Run (or use the Windows command line: Search > CMD > (Right click) Run as
Administrator)

b. Type REGSVR32 /U "C:\Program Files\Matrox DSX-

TopologyUtils\System64\mvfDsxCore.dll" and press ENTER.

2. Shut down http://X.info in the task manager (mveXinfo.exe).
3. Delete mvfDsxCore.dll from the folder C:\Program Files\Matrox DSX-TopologyUtils\System64\.
4, Start http://X.info (mveXinfo.exe).

2.8.14 OtherVideo Boards

* When Viz Engine is in On Air mode, there might be audio distortions using Bluefish cards (VIZENG-8853).
¢ Bluefish Supernova S+ cards can only be used in a Virtual Set Environment if the board is synced to
Blackburst/Trilevel.

2.8.15 NDI

Security Updates Windows 11 - KB5063878 and Windows 10 - KB5063709 can lead to traffic drops in NDI output.

2.8.16 NVIDIA

* When the computer is running out of virtual page size and the user keeps ignoring the low memory warnings
in the console, the NVIDIA driver may cause Viz Engine to crash.

* The NVIDIA driver doesn't recognize other GPUs under certain circumstances in combination with video wall
mosaic installations. Remove and reinstall the driver.

2.8.17 Graphic Hub

e Communication with the Graphic Hub Server might fail if virtual network adapters are active. Please disable
all virtual adapters or increase the timeout.
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¢ |f the connection to the naming server fails, please verify the communication port in the config file (Port
19396).

2.8.18 Adaptive Scene Design

¢ WindowMask plug-in prevents Flexbox labels from being picked.

2.8.19 Audio

® Unplugging a USB microphone from the machine while EAS is enabled freezes Viz Engine without the
possibility to recover (VIZENG-29571).

2.9 Supported Hardware and Software
This software has been tested to run on:

e Windows 11 (LTSC 2402)

o Windows 10 (LTSC 21H2) & (LTSC 1809)%)
e Windows Server 2022, Windows Server 2019

() Ynreal Engine requires a newer Windows 10 version than 1809. UE Integration was successfully tested with 21H2

Note: Only English language Operating System(s) are supported.

2.9.1 Supported Systems

System

Lenovo P3 Ultra
Lenovo P620
Lenovo SR655 V3
DELL R7920

HP Z8 G5 Fury
HP 728 G4

HP Z4 Rack G5
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System
HP Z4 G4

HP ZCentral 4R

2.9.2 Supported GPUs

Ada
Lovelace
GPUs

Blackwell
GPUs

RTX 6000
Ada

RTX 5000
Ada

RTX 4500
Ada

RTX 4000
Ada SFF

RTX 2000
Ada

Ampere
GPUs

RTX A6000

RTX A5500

RTX A5000

RTX A4500

RTX A4000

RTX A2000

RTX A3000

(mobile)

RTX A2000
(mobile)

RTX A1000
(mobile)

Turing
GPUs

RTX
6000

RTX
5000

RTX
4000

RTX
3000

T1000

Pascal
GPUs

Volta
GPUs

GV10 Quadro
0 P6000

Quadro
P5200

Quadro
P4200

Quadro
P4000

Quadro
P3200

Quadro
P2200

Quadro
P2000

Quadro
P1000

Viz Engine Release Notes - 5.4

Maxwell
GPUs

Quadro
M6000

Quadro
M4000

Quadro
M2000

Orange entries are recommended for rendering photo-realistic graphics on the Viz

Engine Pipeline.

Kepler
Gpus (M

Quadro
K6000

Quadro
K5000

Quadro
K5200

Quadro
K4000

Quadro
K4200

Quadro
K2000

Quadro
K2200

(1) Kepler GPUs require an older driver version (473.47). Supported on the Classic Render

Pipeline for backward compatibility only.
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2.9.3 Supported Video Boards

Video Board

Configuration

Matrox Electronic Systems Ltd

Matrox X.mio5/X2 SDI

Matrox X.mio5/8 SDI

Matrox X.mio5 IP

Matrox X.mio3 Full Height
Matrox X.mio3 12G

Matrox M.264 S1/S2/S3/
S4

Matrox DSX LE 5L /4
Matrox DSX LE 4 /8
Matrox DSX LE 4 /4
Matrox DSX LE 4 IP
BlueFish Technologies
Bluefish Epoch Neutron

Bluefish Epoch 4K
Supernova

Bluefish Epoch Supernova
S+

Bluefish Kronos K8

Up to four 12G SDI input with up to four SDI 12G SDI outputs
variable configuration from 12inOout to Oin12out

Up to four 12G SDI input with up to four SDI 12G SDI outputs
variable configuration from 8inOout to Oin8out

Up to 32 ST 2110 inputs and 32 ST 2110 outputs depending on
used SFPs and resolution

Various input/output configurations from 48 to 84
Two 12G inputs, two 12G outputs

H.264 Encoder/Decoder board

Various input/output configurations from 04 to 40, all in 12G
Various input/output configurations from 08 to 80
Various input/output configurations from 04 to 40

Various input/output configurations from 04 to 40

Two video inputs, two video outputs (fill & key)

Two video inputs, two video outputs (fill & key)

Two video inputs, two video outputs (fill & key)

Four video inputs, two video outputs (fill & key)
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Video Board Configuration
AJA Video Systems, Inc.
AJA 104K Plus Two video inputs, two video outputs (fill & key)

AJA Kona 4 Two video inputs, two video outputs (fill & key)

Please refer to the Viz Engine Administrator Guide for which drivers and driver settings to use.

2.10 Build Information

Platform Toolset: Visual Studio 2022 (v143)
Windows SDK Version: 10.0.22621
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3 Documentation

o Info: Starting with Viz Artist/Viz Engine 5.4.0, the installer no longer installs an offline documentation.

Documentation for Viz Engine, Viz Artist and Viz Plugins is available online on the Vizrt Documentation Center:

® Viz Artist User Guide
¢ \/iz Engine Administrator Guide
¢ \iz Plugins User Guide

Copyright © 2025 Vizrt Page 52


http://documentation.vizrt.com/viz-artist
http://documentation.vizrt.com/viz-engine
http://documentation.vizrt.com/viz-artist

Viz Engine Release Notes - 5.4

4 Installation and Support

4.1 Installation

The installation wizard guides you through the installation process. Make sure to close any running Viz application
prior to the installation. In order to run Viz Artist or Viz Engine independent of a database server, you need to install
the Viz Graphic Hub database software locally.

4.2 Support

Supportis available at the Vizrt Support Portal.
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